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RESUMEN 

El objetivo principal de esta investigación fue determinar la variabilidad espacio- 

temporal de la cobertura vegetal en el Parque Nacional de Cutervo durante el periodo 2010 – 

2021. Para lo cual se utilizaron datos de imágenes satelitales de tipo Landsat 7 y Landsat 8, el 

desarrollo se realizó a través de la técnica de clasificación no supervisada con el software 

ArcGIS y QGIS, logrando la clasificación de 4 categorías aplicando el Índice de Vegetación 

de Diferencia Normalizada (NDVI). El trabajo de investigación fue de tipo descriptiva 

correlacional, con la utilización de un diseño de investigación no experimental de naturaleza 

longitudinal; los resultados obtenidos fueron que el suelo desnudo se ha incrementado en 

115.46 ha siendo equivalente a un 12.78%, la vegetación escasa se incrementó en 26.49 ha 

equivalente a un 7.39%, la vegetación semi densa se incrementó en 184.96 ha equivalente a un 

12% y la vegetación densa se redujo en 446.81 ha de bosque equivalente a un 8.39%, en el 

periodo del 2010 al 2021. 

Palabras clave: Imagen satelital, área natural protegida, cubierta vegetal. 
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ABSTRACT 

The main objective of this research was to determine the spatial-temporal variability of 

vegetation cover in Cutervo National Park during the period 2010 - 2021. Satellite image data 

from Landsat 7 and Landsat 8 were used for this purpose. The analysis was conducted using 

the unsupervised classification technique with the software ArcGIS and QGIS, Achieving the 

classification of 4 categories by applying the Normalized Difference Vegetation Index (NDVI). 

The research work was descriptive correlational in nature, utilizing a non-experimental 

longitudinal research design; the results obtained indicated that bare soil increased by 115.46 

hectares, equivalent to 12.78%, and sparse vegetation increased by 26.49 hectares, equivalent 

to 7.39%, the semi-dense vegetation increased by 184.96 hectares, equivalent to 12%, while 

dense vegetation decreased by 446.81 hectares of forest, equivalent to 8.39%, during the period 

from 2010 to 2021. 

Key words: Satellite imagery, protected natural area, vegetation cover. 
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CAPITULO I: INTRODUCCIÓN 

1.1. Realidad problemática 

En los últimos años la evolución de la actividad humana se considera como la mayor 

fuerza que altera los ecosistemas sobrepasando las fuerzas naturales, ya que estos son 

responsables de un gran porcentaje de los cambios y alteraciones en los ecosistemas. Dentro 

de las principales afectaciones ambientales generados por el ser humano tenemos: 

trasformación de la cubierta vegetal, degradación de suelos, utilización intensificada del suelo 

(Granados et al., 2022). Dichas afectaciones ambientales se interrelacionan entre si ya que por 

lo general la pérdida o cambio de la cubierta vegetal casi siempre se relaciona con la 

degradación del suelo generando un impacto en el futuro sobre las propiedades del suelo. “El 

cambio y la pérdida de la cubierta vegetal es el primer paso del proceso de deterioro del suelo; 

si éste no se controla a tiempo, provocará que el paisaje se desertifique” (Muñoz et al., 2009, 

p.12).  

Acorde con el Ministerio del Ambiente (MINAM, 2015), nuestro país posee una gran 

diversidad; dado que poseemos una compleja y gran variedad geomorfológica, edáfica, 

climática y vegetal. Tanto la flora como la vegetación poseen gran variedad, además de estar 

distribuidas en distintos entornos, que van desde extensas zonas montañosas, llanuras aluviales 

con bosques lluviosos, hasta llanuras desérticas y semidesérticas. Esto hace que muchas de las 

zonas con vegetación sean vulnerables al cambio de cobertura vegetal ocasionada por los 

pobladores aledaños a las zonas de interés.  

“Los estudios relacionados con los cambios progresivos en la cobertura vegetal, han 

cobrado importancia en la investigación ambiental, ya que han permitido evaluar las tendencias 

espacio-temporales de procesos como la deforestación y degradación ambiental, provocadas 

por actividades humanas” (Osuna et al., 2015, p.1). 
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La primera área natural protegida en el Perú y además de ser uno de los principales 

ecosistemas nacionales El Parque Nacional de Cutervo, cuya finalidad es proteger la diversidad 

biológica de la cuenca del Marañón, está ubicada sobre cinco zonas de vida, situado en la eco 

región del páramo en la cordillera de Tarros  (Servicio Nacional de Áreas Naturales Protegidas 

por el Estado, 2010).  No obstante, últimamente las acciones antrópicas se han vuelto uno de 

los principales entes que contribuyen a la trasformación del ecosistema, destruyéndolos o 

alterándolos para expandir sus actividades económicas sin considera los impactos y afectos que 

adversos que estas traen a los sistemas y recursos naturales (Morales et al., 2016). Este cambio 

de cobertura vegetal ha estado ocurriendo desde hace ya muchos años atrás y presenta una serie 

de desafíos ambientales y ecológicos que amenazan la integridad de este ecosistema único. 

Dentro de las principales actividades humanas que están afectando esta área natural tenemos 

el aumento de la ganadería y agricultura, la tala indiscriminada de los bosques, junto con 

factores como por ejemplo el cambio climático, han contribuido a disminuir y perder la cubierta 

vegetal original.  

La carencia de investigaciones y estudios sobre la cobertura vegetal y sus cambios en 

el Parque Nacional de Cutervo dificulta generar un análisis a detalle de las causas, las 

consecuencias y la magnitud de estos cambios. Por lo tanto, es esencial abordar esta 

problemática mediante una investigación científica que evalúe el cambio de la cobertura 

vegetal en el Parque nacional de Cutervo en el trascurso de la última década.  

1.1.1. Antecedentes 

1.1.1.1.Internacionales 

El trabajo denominado “Análisis multitemporal del cambio de cobertura vegetal en el 

área de manejo Los Números” elaborado por (Figueroa et al. 2020), el objetivo principal de 

este estudio fue la evaluación de una dinámica espaciotemporal del cambio de cobertura del 

suelo durante el periodo de 1986 y 2016; por lo tanto, clasificaron en cuatro categorías de 



“ANÁLISIS DE LA VARIABILIDAD ESPACIO - TEMPORAL DE LA COBERTURA VEGETAL EN EL 

PARQUE NACIONAL DE CUTERVO DURANTE EL PERIODO 2010 - 2021” 

 

 

Carrasco, H.; Flores, L. Pág. 14 

 

ocupación la cobertura, las cuales son: bosques, pastos o cultivos, suelo desnudo, herbazales y 

arbustivos. Utilizando e método de clasificación supervisada de imágenes satelitales Landsat 5 

y Landsat 8. Obteniendo resultados que, en el período analizado, se produjo una disminución 

en las zonas arbustivas de 20,91 km² y 6,65 km² de suelo desnudo; así como 6,38 km² de la 

cubierta herbácea, cultivos o pastos; en tanto el 33,94 km² de los bosques representaron el 

aumento del límite de la cubierta forestal.  

Acorde con el estudio denominado “Análisis de cambio en la cobertura vegetal y uso 

del suelo en la región centro-norte de México. El caso de la cuenca baja del río Nazas” 

elaborado por (Leija et al., 2020), plantearon como objetivo la evaluación en la cuenca baja del 

Río Nazas, con respecto a los cambios en el uso del suelo y las coberturas vegetales en el 

periodo 1990-2016. Utilizando imágenes satelitales de Landsat TM y ETM, con las cuales 

elaboraron las bases de datos sobre uso actual del suelo y cobertura vegetal. Obteniendo que el 

32,1% de las coberturas naturales fueron deforesto en los últimos veinticinco años. 

En la investigación “Cambio de cobertura vegetal en la región de Bahía de Banderas, 

México” elaborado por (Morales et al., 2016) cuyo objetivo fue analizar las series de tiempo y 

observación de la trasformación de la cubierta de vegetal, utilizando una clasificación 

supervisada por medio de un Sistema de Información Geográfica (SIG). Evidenciando como 

resultado un proceso de modificación y reposición de coberturas y usos del suelo, en lo cual 

los usos relacionados con la agricultura están experimentando un aumento significativo, 

comprendiendo el desarrollo activo como el cambio a vegetación secundaria, se ha 

experimentado la mayor tasa de deforestación en los últimos años a expensas de las zonas 

boscosas y selvas. 

Según una investigación realizada por (Osuna et al., 2015) llamado “Evaluación del 

cambio de cobertura vegetal y uso de suelo en la cuenca del río Tecolutia, Veracruz, México; 

periodo 1994-2010” cuyo principal objetivo fue medir los efectos de la actividad humana en la 
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cuenca del río Tecolutla, Veracruz, México, en un lapso de tiempo de 6 años. Para los años de 

1994 y 2010, utilizaron imágenes satelitales tipo Landsat de esta forma lograron identificar 9 

usos y coberturas de suelo, que son: asentamientos urbanos, cultivos de cítricos, suelo agrícola, 

pastizales, vegetación perturbada, bosques, selva, agua y matorrales. La consecuencia fue un 

aumento en la cantidad de áreas destinadas a actividades humanas (agricultura y uso urbano), 

en un periodo de 16 años mostro variación del 28% y 67%, correspondientemente. Como 

resultado, en las superficies con coberturas naturales, hubo un registró de disminución del -

1.1% anual principalmente en selvas y bosques. Esto se asemeja a estudios realizadas a nivel 

nacional y estatal, verificando la transición de las coberturas naturales debido al aumento de 

las acciones humanas.  

1.1.1.2.Nacionales 

(Zuloaga & Gabriel, 2023), ostentaron una investigación nombrada “Cambio de uso de 

tierra y su impacto en la cobertura vegetal del Parque Nacional Tingo María entre los años 

2006-202”, teniendo como propósito la identificación de actores o agentes territoriales 

vinculados al impacto generado en el Área Natural Protegida (ANP). Para llevar a cabo dicha 

investigación, se avalaron de algunas metodologías, entre las cuales estaba la cualitativa, con 

el fin de aplicar entrevistas semiestructuradas con una observación no participativa; por otro 

lado, la cuantitativa, para procesar imágenes satelitales con el fin de poder determinar la tasa 

de cambios que sufrió el uso de tierra. Aplicando dichas metodologías, lograron identificar las 

coberturas de suelos afectados, así como la cobertura vegetal, cada uno establecidos en áreas 

específicas de uso, asociados a prácticas de una agricultura extensas las cuales fueron 

destinadas al autoconsumo y al mercado local. Por último, concluyeron que los cambios que 

soportaron las coberturas, en contraste con otras ANP, no fueron relevantes, debido a la 

colaboración conjunta de algunas instituciones y pobladores locales que pudieron frenar el 

levantamiento de actividades que son ilícitas y no autorizadas las cuales lograran impactar 
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claramente la cobertura vegetal del PNTM, representando un guía de misión eficaz para un 

espacio natural que ofrece una variedad de beneficios ecosistémicos. 

Por otro lado, (Aguilar, 2022), en su investigación “Variación espaciotemporal de la 

cobertura vegetal de la subcuenca Santa Eulalia (Lima-Perú) en el período 2003 – 2019”. Se 

propuso como objetivo analizar la cobertura vegetal de la subcuenca Santa Eulalia. Para lo 

cual, aplico una metodología descriptiva univariable. Con el fin de medir la cobertura de la 

subcuenca uso el índice NDVI. Con dicha metodología y medición logro demostrar que la 

cobertura vegetal de poca densidad disminuyó a 2.65 km²/año, ya que el área de la cobertura 

vegetal densa disminuyo a 0.81 km²/año, de 19 km² (2003) a 10.6 km² (2019). Así mismo, el 

mapa cartográfico indica que en los valles altoandinos hay una cobertura vegetal densa, 

mientras que en toda la parte media de la subcuenca hay una vegetación poco densa. 

(Guerra, 2020), planteo como objetivo principal la realización de un estudio sobre la 

cobertura vegetal en espacio y tiempo durante el periodo 2000 – 2019 con relación al desarrollo 

poblacional de la provincia de Lima. Para logra dicho objetivo se planteó usar un diseño 

descriptivo correlacional. Para el cálculo de la cobertura uso la técnica NDVI; utilizando como 

apoyo las imágenes satelitales previamente tratadas; mientras que, el monto poblacional fue 

obtenida de los censos nacionales. Logrando una relación de tipo negativa alta; así mimo; se 

dio a conocer que hubo un declive de 1.73% de la cobertura vegetal en toda la ramificación de 

la zona de investigación. Por último; el área estudiada mostró una caída de 2769.5 en cobertura 

vegetal presentando una correlación del 86% con el aumento poblacional. 

En la tesis sustentada por (Gallardo & Montalván, 2020), plantearon examinar la 

disminución de la cobertura vegetal en el distrito de Morales (San Martin – Perú), durante los 

años de 1987 – 2017. Donde recurrieron al análisis multitemporal de imágenes satelitales, para 

lo cual, utilizaron el software ArcGIS empleando la técnica de clasificación supervisada. Dicha 

técnica les permitió estudiar los periodos 1987-1997, 1997- 2007 y 2007-2017; Arrojando 
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como resultado que la cobertura vegetal se vio afectada durante el periodo 1987 – 1997 se 

perdió 948.42 ha; por otro lado, en el periodo 1997-2007 la disminución fue de 81.83 ha, La 

pérdida entre 2007 y 2017 fue de 59,26 ha. Por la tanto, concluyendo que el crecimiento 

demográfico tiene un papel importante en la disminución de la cobertura vegetal en el distrito 

estudiado. 

En el proyecto de tesis designada “Variabilidad espacio-temporal de la vegetación en 

la cuenca Quilca-Chili durante el periodo 2005-2015” elaborada por (Manchego, 2017), se 

propuso como objetivo principal la estimación de la variabilidad de la vegetación en la cuenca. 

Para logra dicha evaluación se apoyó en el Índice de Vegetación de Diferencia Normalizada 

(NDVI), con el que puedo evaluar el grado de desertificación que se produjo durante los años 

2005 y el año 2015.  Para lo cual su metodología residía en recopilar imágenes del Satélite 

Landsat (5 y 7) conveniente a los meses de septiembre, octubre y noviembre, con el propósito 

de poder determinar el NDVI en los distintos año mencionado en el estudio. En consecuencia, 

se evidencio que la existencia de la cobertura vegetal en dicha cuenca aumenta y disminuye 

periódicamente, esto se debe a las variables climáticas y los pisos altitudinales. Se concluyo 

que desde 2005 hasta 2015, la cobertura vegetal fue próspera, puesto que el NDVI cambió de 

0,107 a 0,131; evidenciando que la vegetación inicio con 6061,39 km2 y concluyó con 7854,38 

km2.  

(Nina, 2016), presento un estudio nombrado “Cambios de la cobertura del suelo en la 

Reserva Nacional Salinas y Aguada Blanca Arequipa, Moquegua - Perú, con relación a la 

variación de la temperatura y precipitación durante el periodo 1986-2010”. En dicho estudio 

pudo obtener resultados desde el año 1986 al 2010 los cuales suman un total de 24 años, dichos 

resultado arrojaron que, en el conjunto de suelos con vegetación, la mayor pérdida que presnta 

los pajonales son de -55,99%, la deforestación o cambio -3,36% y presento una baja 

permanencia de 28,10%. Así mismo, el 75,39% de cobertura lo ocupo el césped de puna, con 
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una tasa de reforestación de 2,37% y su cabida para conservar fue la más alta con un 75,91%. 

Durante dicha etapa, para los suelos que tienen poca o ningún tipo vegetación, los nevados 

presentaron una caída de -96,29% con una tasa de cambio de -12,83%, además de una 

permanencia baja de tan solo 3,63%; por el contrario, el suelo pobre de vegetación aumentó un 

33,45% con una tasa de cambio del 1,21% y obteniendo un mayor equilibrio equivalente a 

97,56%. Referente al NDVI, el promedio de la cobertura vegetal, monte ribereño y la 

agricultura exhibió una superior eficacia con 0,17, continuado por el bofedal con 0,16; por otro 

lado, el pajonal y tolar alcanzaron valores mucho más bajos, únicamente con 0,02. El año 1986 

presento una mayor tabla de vigor de 0,10 mientras que en 1992 solo se alcanzó 0,06. 

1.1.1.3.Locales 

De acuerdo a la investigación denominada “Análisis de cambio de cobertura y uso de 

la tierra con imágenes satelitales del distrito de Socota - Cutervo período 2002-2017”, realizada 

por (Idrogo, 2022), planteó como objetivo que mediante el uso de imágenes satelitales Landsat 

5 (2002) y Landsat 8 (2017), además de utilizar la metodología y clasificación de cobertura 

terrestre Corine Land Cover, buscó identificar las trasformaciones de cobertura y uso del suelo. 

concluyendo que durante los años analizados ocurrieron modificaciones de un total de 15 

468.20 ha, causando impacto en la cobertura del uso de la tierra con un total de 5 539.95 ha 

correspondiente al 35.82 % y sin cambio para 9 928.25 ha proporcional al 64.18 %. Un área de 

9928.21 ha no experimentó cambios durante la transición de la cobertura y uso del suelo a lo 

largo de los años 2002 y 2017. 

De acuerdo con la investigación denominada “Estudio de la Evolución de la Cobertura 

Vegetal de los Suelos mediante Imágenes Landsat, Distrito Sexi – Cajamarca”, elaborada por 

(Pinzón, 2022). planteó como principal objetivo evaluar el desarrollo y las tendencias de la 

cobertura vegetal. Para lo cual utilizó imágenes que tenían menor nubosidad. Llegando a la 
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conclusión de que las coberturas de roca son más comunes, ocupando en promedio de 9025.5 

ha representado el 47.51% de la superficie del distrito. Durante los últimos 30 años, se a 

estudiado el comportamiento de los tipos de cobertura rala y rocosa. La cobertura semidensa, 

fue la que se mantuvo con menos cambios en el espacio-tiempo, siendo la más estable. Seguido 

de la cobertura densa, la cual experimentó puntos de disminución significativos, como en 1991. 

Para (Gutiérrez & Vílchez, 2022), en su investigación “Evaluación de cobertura vegetal 

en el distrito de Cajamarca utilizando dos técnicas espectrales del 2000 al 2020”, el objetivo 

de su investigación fue que con la utilización de técnicas espectrales como el índice de 

vegetación de diferencia normalizada, definirá el porcentaje generado por la degradación de 

cubiertas vegetales en el distrito de Cajamarca entre los años 2000 a 2020, en función del Índice 

de Vegetación de Diferencia Normalizada (NDVI) obtenido de imágenes satelitales Landsat 7 

ETM+ y Landsat 8 junto con una combinación de bandas 451 y 562, se determinó que la 

cobertura vegetal ha variado. Utilizando la metodología no experimental – longitudinal – 

correlacional. Los hallazgos indicaron que la degradación más significativa de la cobertura de 

tipo forestal fue de -8.23% durante el periodo 2016 al 2018, del -6.59% en el periodo de 2010 

a 2012 y del 0.28 % en el periodo de 2014 a 2016. De manera similar la cobertura vegetal de 

tipo No boscoso como son los pajonales andinos y matorrales arbustivos, experimentaron la 

mayor degradación en el periodo de 2000 a 2002 equivalente a 1.84 %, 2008 a 2010 con un 

porcentaje de 1.16 y del 2012 a 2014 con una tasa del 1.24%.  

En la investigación “Variabilidad temporal y espacial de la vegetación en la 

microcuenca del río Porcón durante el periodo 2003 – 2019”, realizada por (Ugaz, 2020), 

planteó el propósito de establecer la variación espacio- tiempo de la vegetación en la 

microcuenca del río Porcón, durante los años 2003- 2019, usando el Índice de Vegetación de 

Diferencia Normalizada (NDVI). Se identifico que la presencia de cobertura vegetal en la 

microcuenca del río Porcón ha experimentado una inclinación tanto ascendente como 
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descendente. De 2003 a 2019, la vegetación clasificada como escasa experimentó una 

disminución del 7,6% a 6.18% respectivamente, de la misma manera la vegetación 

medianamente densa disminuyo de 73.97% a 72.5%; según el promedio NDVI de la 

microcuenca, se fijó un índice de 0,6 que indica una vegetación densa en promedio. 

Para (Saldaña, 2019), en su estudio de investigación llamado “Análisis de los cambios 

de cobertura y uso de suelo con imágenes satelitales del distrito de Chancay, años 2001 y 2018”, 

Con la utilización de la técnica de Corine Land Cover realizo la clasificación supervisada, 

obteniendo como resultado que en un lapso de 17 años hubo un cambio de 2470.29 ha. lo que 

representa el 34.74 % del área en general, obteniendo que la categoría herbácea ha aumentado 

479.04 ha. de 220.35 ha. a 699.39 ha., esta categoría se ha incrementado significativamente, 

involucrando la degradación de otras coberturas, como la categoría de cultivos transitorios la 

cual perdió 811.82 ha. 

1.1.2. Bases teóricas 

Variabilidad espacio-temporal 

(Alencar et al., 2019).  define a la variabilidad espacio-temporal como el contraste de 

las propiedades y/o características de un método o sumario a través del espacio y a lo extenso 

de diferentes etapas de tiempo. Así mismo, afirma que es un texto importante en el ámbito de 

las ciencias ambientales, ya que, ha aprendido en correspondencia con la dinámica de emporios 

y en relación con su entorno. Por otro lado, menciona que la variabilidad puede enfocarse en 

la cobertura vegetal refiriéndose a la diferencia en las características de la vegetación a través 

del tiempo y espacio. Así mismo, menciona que una de las herramientas primordiales es el 

Índice de Vegetación por Diferencia Normalizada (NDVI), que ayuda a identificar la 

vegetación, de acuerdo con la consistencia del área forestada. Los resultados encontrados con 

el NDVI ayudan a identificar el cambio que ocurre en las coberturas vegetales a través del 

tiempo además de ser útiles para realizar una clasificación de la vegetación. 
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Cobertura vegetal 

Una de las tantas definiciones que se le puede dar es que puede ser una capa de 

vegetación nativa o labrada que mayormente recubre superficies físicas, alcanzando una 

extensa escala de biomasas con una amplia gama de cualidades fisionómicas y ambientales los 

cuales abarcan áreas revestidas por bosques naturales hasta pastizales. Por otro lado, se incluyes 

coberturas vegetales provocadas que son el resulta del ejercicio humano tales como las áreas 

de cultivos (MINAM, 2019, p.1). Para (Pedroza et al., 2021) mencionan que puede estar 

concertada por vegetación, residuos vegetales o manto orgánico. La cual puede ser una defensa 

que posee el suelo dado que mitiga el desgaste hídrico, ocasionado por la escorrentía ligero 

procedentes de las precipitaciones, reduciendo la energía producida por el escurrimiento 

superficial del agua desempeñando el cargo de barrera superficial en el suelo atenuando este 

impacto erosivo. Así mismo, indica que los diversos estudios han determinado que la cobertura 

somete la compactación del suelo mejorando su estructura, esta cobertura también aumenta. 

NDVI (Índice de vegetación de diferencia normalizada) 

“El NDVI es el más frecuente entre los índices de vegetación procedentes de 

observaciones en imágenes de percepción remota. Se basa en la analogía entre la cantidad de 

luz reflejada (reflectancia) por el plano terrestre en dos regiones del espectro electromagnético, 

luz roja e infrarroja (infrarrojo cercano)” (Instituto Nacional de Estadística y Geografía, 2022, 

p.1). “Debido a la impregnación de la clorofila, las hojas verdes irradian muy poca luz 

conveniente al rojo, mientras que exponen una alta reflectancia en la zona del infrarrojo 

contiguo” (Girimonte & García, 2020, p.4). Los valores pequeños de reflectancia en el espectro 

visible del infrarrojo muestran una mayor actividad fotosintética o un mayor aspecto y 

consistencia de vegetación. La utilización del (NDVI) se torna fundamentalmente notable 

cuando se dispone de exámenes en distintas fechas, permitiendo el estudio de sucesiones 

temporales. La investigación de estos encadenamientos temporales facilita la monitorización 
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de la vegetación y la caracterización de canjes en la cobertura/uso del suelo, la valoración de 

la fase de los cultivos de productos agrícolas, la determinación de la fenología vegetal y el 

rastreo de sucesos como la sequía, como lo demostró el INEG (Instituto Nacional de Estadística 

y Geografía), sin fecha específica (INEG, 2022).  

Para (Girimonte & García, 2020, p.4) el Normalized Difference Vegetation Index 

también conocido como (NDVI) menciona que es un índice que deriva de la razón entre la 

reflectancia del rojo y el infrarrojo cercano: (Ir – R)/ (Ir+R) 

Donde:  Ir: reflectancia conveniente al infrarrojo contiguo 

R: reflectancia proporcionada al rojo del espectro electromagnético.  

Los datos del índice varían desde -1 y 1. Los valores nocivos son afines con superficies 

y cuerpos de agua, expuestas al fuego.  Mientras tanto los valores positivos más bajos (cercanos 

a 0) incumben a vegetación de baja cobertura o senescente. El alto contenido de biomasa 

fotosintética so simbolizados por valores positivos altos (cercanos a +1). 

Tabla 1  

Clasificación del NDVI  

N° Cobertura Vegetal Rango de NDVI 

1 Cuerpos no vegetales -1 a 0 

2 Suelo desnudo 0 a 0.1 

3 Vegetación escasa 0.1 a 0.2 

4 Vegetación medianamente densa 0.2 a 0.3 

5 Vegetación densa 0.3 a mas 

Nota: Clasificación del NDVI. Adaptado de Índice de vegetación de diferencia 

Normalizada: Análisis y Mapeo de la Deforestación en el Municipio de Bacalar, 

Quintana Roo (p. 33). Cima, 2021 
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Teledetección 

Se define como la capacidad de lograr recabar información de un objeto sin instituir 

contacto corporal directo. Dicho concepto se confina a técnicas que monopolizan la energía 

electromagnética irradiada por objetos. Para la ciencia, la teledetección se precisa como un 

método que se centra en la captura, procesamiento y estudio de imágenes obtenidas a partir de 

un satélite artificial que orbitan alrededor del planeta tierra. Dicha metodología, que facilita la 

recopilación de información remota, basado en el indicio que los materiales en el plano terrestre 

tienen réplicas espectrales distintivas, facilitando la identificación, Por lo tanto, resulta decisivo 

contar con equipos con capacidad para registrar radiaciones derivada del planeta Tierra y 

convertirla en una señal la cual pueda ser manejada tanto de forma analógica como digital. 

(Ugaz, 2020).  

Figura 1  

Sistema de teledetección 

 

a. Radiación incidente. 

b. Radiación reflejada. 

c. Radiación emitida.  

 

 

Nota: Representación de un sistema de teledetección. Tomado de Teledetección 

fundamental (p. 19), por Ormeño, 2006.  

“En lo que concierne a cartografía, la alta resolución espectral de Landsat facilita la 

ejecución de mapas temáticos de varios tipos” (Ormeño, 2006, p.18). afirma que la 

Teledetección de plano terrestre es un sistema, basado en ondas electromagnéticas, la cual se 

define por la afluencia de algunos elementos tales como: fuentes de radiación electromagnética, 
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la interacción de ondas electromagnéticas con respecto a la superficie terrestre, ondas 

electromagnéticas que interactúan con la atmosfera y receptores de ondas electromagnéticas 

(Ormeño, 2006, p.19). 

Imágenes satelitales 

Las imágenes de satélites son el producto que se obtiene de detener la radiación emitida 

por el plano terrestre, para lo cual se coloca sensores al borde de los satélites artificiales. Dichas 

imágenes poseen rasgos como resolución, elevación colores, entre otros. La altitud y del equipo 

utilizado determinan la calidad de cada imagen obtenida. Una de las desventajas es que si la 

imagen a envolver es amplia el procesamiento es extenso y cabe resaltar que la imagen depende 

marcadamente de la calidad del sensor utilizado (Sánchez, 2012). 

LANDSAT es un grupo de satélites que se conocen como LAND=tierra y SAT=satélite, 

a principios se llamaban ERTS (Earth Resources Technology Satellites - Satélites de 

Tecnología de Recursos Terrestres), fueron el objetivo original del gobierno de Estados Unidos 

con el propósito de monitorear y vigilar los recursos naturales. El grupo de satélites constaban 

de ocho, de los cuales en este momento solo se encuentran en funcionamiento el 5 y el 8. La 

NASA (Administración Nacional de la Aeronáutica y del Espacio) es responsable del 

mantenimiento y la operación. Los diversos instrumentos que llevan a bordo los satélites 

LANDSAT permiten recopilar datos sobre cambios en el uso del suelo, la cobertura del suelo, 

salud de la vegetación, condiciones atmosféricas entre otros aspectos importantes para la 

administración de los recursos naturales y monitorización ambiental. La mejora en la captura 

de datos de la superficie de la tierra es gracias a la evolución de instrumentos los cuales están 

enfocados en la búsqueda de mayores niveles de precisión y detalle. Dicho progreso se 

manifiesta en los aumentos radiométricas, geométricas y espaciales implementadas en los 

sensores pasivos. Estas mejoras constantes tienen como objetivo maximizar la capacidad de 
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estos instrumentos para recopilar datos de la superficie terrestre más precisos y detallados 

(INEGI, 2022). 

Las imágenes Landsat, fruto de una serie de satélites de observación terrestre iniciada 

en 1972. Dichas imágenes combinan canales pancromáticos, visibles, infrarrojos y térmicos, 

con resoluciones espaciales que oscilan entre 15 y 120 metros dependiendo de la banda y el 

sensor. La evolución de dichos satélites, especialmente con el Landsat-8 y sus 11 bandas, ha 

desarrollado elocuentemente las posibilidades de combinación y análisis, permitiendo un 

beneficio más extenso y detallado de los datos para diversas aplicaciones en el estudio y 

observación de la superficie de la tierra (INEGI, 2022). 

Tabla 2  

Característica imagen Landsat 7 

Numero de banda Banda 

Longitud de Onda 

(micrómetros) 

Resolución 

(metros) 

Banda 1 Azul 0.45 a 0.52 30 

Banda 2 Verde 0.52 a 0.60 30 

Banda 3 Rojo 0.63 a 0.69 30 

Banda 4 Infrarrojo Cercano (NIR) 0.77 a 0.90 30 

Banda 5 Onda corta infrarroja (SWIR) 1 1.55 a 1.75 30 

Banda 6 Thermal 10.40 a 12.50 30 

Banda 7 Onda corta infrarroja (SWIR) 2 2.09 a 2.35 30 

Banda 8 Pancromática 0.52 a 0.90 15 

Nota: ETM + Band 6 se obtiene a una resolución de 60 metros, pero el producto se 

vuelve a muestrear a los píxeles de 30 metros. Característica imagen Landsat 8. Tomado 

de Teledetección Espacial Landsat, Sentinel 2, Aster L1t y Modis (p. 20), por Bravo, 

2017. 
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Tabla 3  

Característica imagen Landsat 8 

Numero de 

banda 

Banda 

Longitud de Onda 

(micrómetros) 

Resolución 

(metros) 

Banda 1 Ultra azul (costero / aerosol) 0.43 a 0.45 30 

Banda 2 Azul 0.45 a 0.51 30 

Banda 3 Verde 0.53 a 0.59 30 

Banda 4 Rojo 0.64 a 0.67 30 

Banda 5 Infrarrojo Cercano (NIR) 0.85 a 0.88 30 

Banda 6 Onda corta infrarroja (SWIR) 1 1.57 a 1.65 30 

Banda 7 Onda corta infrarroja (SWIR) 2 02.11 a 02.29 30 

Banda 8 Pancromática 0.50 a 0.68 30 

Banda 9 Cirrus 1.36 a 1.38 30 

Banda 10 Infrarrojo térmico (SITR) 1 10.60 a 11.19 100 

Banda 11 Infrarrojo térmico (SITR) 2 11.50 a 12.51 100 

Nota: Característica imagen Landsat 8. Tomado de Teledetección Espacial Landsat, 

Sentinel2, Aster L1t y Modis (p. 21), por Bravo, 2017* Bandas TIRS se adquieren a 

una resolución de 100 metros, pero se vuelven a muestrear a 30 metros de producto 

entregado datos. 

Sistema de información geográfica 

El sistema de Información Geográfica (SIG) se define como métodos integrados y 

lógicos que integran datos geográficos con atributos asociados. Consiente en analizar, capturar, 

transformar, almacenar, visualizar y estudiar información espacial de modo coherente y 

eficiente. Surgidos como respuesta a la necesidad de procesar ágilmente datos geoespaciales, 

los SIG se han transformado en instrumentos esenciales en diversos campos, desde la 
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organización urbana hasta la gestión de recursos naturales. Su capacidad para combinar 

diferentes capas de información y realizar análisis complejos los hacen invaluables para el 

proceso de toma de decisiones apoyadas en datos geográficos, ofreciendo soluciones a 

problemas espaciales y respondiendo a interrogantes de forma inmediata y precisa 

(Geoenseñanza, 2006). 

Espectro electromagnético 

La radiación electromagnética es la manifestación de energía en forma de ondas 

electromagnéticas desde un origen, ya sea natural o artificial. Dichas ondas se determinan por 

su frecuencia, el cual es el número de ciclos por unidad de tiempo. (Luque, 2017). Según 

(Bravo, 2017) el espectro electromagnético contiene todas las frecuencias posibles de radiación 

electromagnética, desde las ondas de radio de baja frecuencia hasta los rayos gamma de alta 

frecuencia, pasando por microondas, infrarrojo, luz visible, ultravioleta y rayos X. 

Firmas espectrales 

Las firmas espectrales simbolizan la intensidad de luz que refleja un objeto. Todos los 

datos de reflectancia son únicos para la medida en la que se tomaron, Los valores para la 

vegetación dependen de la salud de las plantas y la etapa de crecimiento, el nivel de humedad, 

etc. Debido a esto, es crucial e importante conocer las condiciones de la toma de mediciones. 

El análisis de las firmas espectrales de materiales comunes presentes en la superficie de la tierra 

proporciona información crucial para comprender e interpretar las imágenes capturadas por 

sensores remotos (Fajardo, 2018). 

 

1.2.Formulación del problema 

¿Existe variabilidad espacio- temporal de la cobertura vegetal en el Parque Nacional de 

Cutervo Durante el periodo 2010 – 2021? 
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1.3.Objetivos 

1.3.1. Objetivo General 

• Determinar la Variabilidad Espacio- Temporal de la Cobertura Vegetal en el Parque 

Nacional de Cutervo durante el periodo 2010 - 2021. 

1.3.2. Objetivos específicos 

• Desarrollar el índice de vegetación de diferencia normalizada de manera anual 

durante el periodo 2010- 2021. 

• Identificar los factores implicados en la variabilidad espacio temporal de la 

cobertura vegetal en el Parque Nacional de Cutervo durante el periodo 2010- 2021. 

• Proponer medidas de gestión sostenible para la conservación de la cobertura 

vegetal. 

1.4.Hipótesis  

1.4.1. Hipótesis general 

La cobertura vegetal en el Parque Nacional de Cutervo ha experimentado variaciones 

durante el periodo 2010 - 2021. 

1.4.2. Hipótesis alternativa 

Existe una variación superior al 5% en cada tipo de cobertura vegetal del Parque 

Nacional de Cutervo durante el periodo 2010- 2021. 

1.4.3. Hipótesis nula  

Existe una variación inferior al 5% en cada tipo de cobertura vegetal del Parque 

Nacional de Cutervo durante el periodo 2010- 2021. 
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CAPITULO II: METODOLOGÍA 

2.1.Tipo de investigación 

Este estudio adopta un enfoque descriptivo ya que acorde a lo que menciona García 

(2004)  estos son estudios en los que la variable de estudio no es manipulada o intervenida de 

ninguna manera, es decir solo es observada, también posee un enfoque correlacional dado que 

acorde con (Causas, 2015) relata que los estudios con enfoque correlacional son utilizados para 

poder identificar el grado de relación que los estudios tienen entre sí, además de lograr 

identificar si los cambios de una variable afectan a la otra variable. De igual manera el diseño 

de esta investigación fue no experimental ya que acorde con (Agudelo & Aigneren, 2008) la 

variable independiente no será manipulada, es decir no se tendrá una intervención directa, 

además de ser longitudinal como mencionan  (Delgado & Llorca, 2004) dado que un estudio 

longitudinal es aquel se evalúa durante un determinado periodo de tiempo y se identifican los 

cambios en la variable dependiente, dicho diseño implica la observación de cambios a lo largo 

del tiempo en su contexto natural, sin la intervención deliberada en las variables. 

Posteriormente, se analizan estos cambios y se realizan inferencias en relación con las 

transformaciones observadas. 

2.2.Población y muestra 

2.2.1. Población 

Para esta investigación se tomó como población de estudio la totalidad de la cobertura 

vegetal comprendida dentro del área del Parque Nacional de Cutervo abarcando una extensión 

es de 8,214.23 hectáreas. 

2.2.2. Muestra 

Como muestra se consideró el periodo de tiempo comprendido entre los años 2010 al 

2021 de la cobertura vegetal comprendida dentro del área del Parque Nacional de Cutervo que 

abarca una extensión es de 8,214.23 hectáreas. 
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2.3.Materiales, instrumentos y métodos 

2.3.1. Materiales 

• Computadora Portátil 

• Impresora 

• Memoria USB 

2.3.2. Instrumentos 

• Plataforma EarthExplorer (USGS), para la obtener de imágenes de satélite. 

• Imágenes Satelitales de tipo LANDSAT 8 Y LANDSAT 7. 

• Softwares: ArcMap 10.8, Qgis 3.32.3, Google Earth Pro. 

2.3.3. Método 

La investigación realizada es de tipo analítica-descriptiva dado que se realiza una 

comparación de información de años anteriores con información más actualizada, el análisis 

de ambas es plasmado en una comparación de datos y determinar los cambios existentes. La 

metodología utilizada es la deductiva dado que vamos de un aspecto general a uno más 

específico.    

2.4.Procedimiento 

Los siguientes pasos se tomaron para desarrollar la investigación, los cuales van desde 

planificación, ejecución y análisis de datos, se refrentarán en el siguiente diagrama de flujo: 
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Nota: Elaborado por los autores 

2.4.1. Determinación del área de estudio 

Para esta fase se determinó el área donde se llevará a cabo el estudio, siendo el Parque 

Nacional de Cutervo, según el Servicio Nacional de Áreas Naturales Protegidas por el Estado 

(SERNANP), el PNC cuenta con las siguientes características: 

Creación: Creado el 20 de septiembre de 1961, el Congreso de la República lo 

promulga al Poder Ejecutivo, entrando en vigencia el 20 de septiembre mediante Ley Nº 13694. 

Determinación del área de estudio 

Descarga de información tipo shapefile 

Descarga de imágenes satelitales 

Corrección de bandeo LANSAT 7 

Procesamiento de imágenes satelitales 

Cálculo del NDVI (Índice de Vegetación de 

Diferencia Normalizada) 

Análisis de datos 

Figura 2  

Diagrama de flujo del proceso metodológico 
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Ubicación: Se encuentra situado en la provincia de Cutervo ocupando cierta área de los 

distritos de Santo Tomas, Santo Domingo de La Capilla, San Andrés de Cutervo, Santa Cruz 

de Cutervo, Callayuc y Pimpingos, colinda con los distritos de Sócota y Cutervo.  

Clima: Predomina el húmedo a semifrío, con lluvias temporales entre octubre y marzo. 

El flanco occidental presenta uno típico de sierra, mientras que el oriental presenta un clima 

típico de selva alta.   

Temperatura promedio: La temperatura promedio es de 12° C a 19° C 

Superficie: La superficie total es de 8,214.23 ha.  

Precipitación anual: De 780 mm (SERNANP, 2019).
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Figura 3  

Mapa de ubicación del Parque Nacional de Cutervo 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8
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2.4.2. Descarga de información tipo shapefile 

En esta parte se descarga la información de todas las ANP de la página GEO ANP Visor 

de las áreas naturales protegidas perteneciente al portal del SERNANP 

(https://geo.sernanp.gob.pe/visorsernanp/), cuya información esta disponible en formato 

shapefile, posterior a ello se abrió el programa ArcGIS 10.8 en el cual se carga la capa de 

shapefile de las ANP, se abre la tabla de atributos de la capa shapefile y se seleccionó el 

polígono del PNC para luego exportarlo; luego se procedió a modificar el sistema de 

coordenadas de la capa shapefile siguiendo la secuencia que se muestra a continuación: 

ArcToolbox > Data Management Tools > Projection and Transformations > Define 

Projection, de esa forma se transformó el sistema de coordenadas a WGS 84 UTM Zona 17 

Sur.  

Figura 4  

Shapefile de las Áreas Naturales Protegidas por el Estado 

 

Nota: Elaboración propia asistida con el Software ARCGIS 10.8 
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2.4.3. Descarga de imágenes satelitales 

Se usaron imágenes satelitales gratuitas de la página EarthExplorer (usgs.gov) 

perteneciente al USGS (Servicio Geológico de Estados Unidos); primero se convirtio el 

shapefile del PNC a formato KML de esta manera delimitar el área de estudio y poder ubicar 

las imágenes satelitales con mejor facilidad, para lo cual se continuó la siguiente secuencia: 

ArcToolbox > Conversión Tools > To KML > Layer To KML. Se determinó el área a descargar 

y se procedió a identificar las imágenes satelitales, el rango de descarga correspondió al periodo 

2010 – 2021, identificando la imagen correspondiente del 2010 de tipo LANDSAT 7 y las 

posteriores de tipo LANSAT 8, para los años: 2011, 2012, 2014, 2015, 2017 y 2019 no se 

realizó la descarga de imágenes satelitales dado que la nubosidad presente en ellas cubrían gran 

parte del área a estudiar, las imágenes que corresponden a los años: 2010, 2013, 2016, 2018, 

2020 y 2021 presentan la menor cantidad de nubosidad sobre la zona de investigación. 

Seguidamente se presenta la tabla de caracterización de las imágenes satelitales seleccionadas 

y descargadas: 

 

 

 

 

 

 

 

https://earthexplorer.usgs.gov/
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Tabla 4  

Caracterización de imágenes satelitales 

Atributo de conjunto de 

datos 

Valor de atributos para los años 

2010 2013 2016 2018 2020 2021 

Identificador de producto 

Landsat L2 

LE07_L2SP_009

064_20101105_2

0200910_02_T1 

LC08_L2SP_009064

_20131105_2020091

2_02_T1 

LC08_L2SP_009064

_20161113_2020090

5_02_T1 

LC08_L2SP_009064

_20181205_2020083

0_02_T1 

LC08_L2SP_009064

_20201226_2021031

0_02_T1 

LC08_L2SP_009064

_20211213_2021122

2_02_T1 

Identificador de escena d 

Landsat 

LE70090642010 

309EDC00 
LC80090642013 

309LGN01 

LC80090642016 

318LGN01 

LC80090642018 

339LGN00 

LC80090642020 

361LGN00 

LC80090642021 

347LGN00 

Fecha de adquisición 5/11/2010 5/11/2013 13/11/2016 5/12/2018 26/12/2020 13/12/2021 

Indicador día/noche Día Día Día Día Día Día 

Cubierta de nubes 

terrestres 
26% 35.69% 54.46% 25.28% 18.41% 48.02% 

Versión del software de 

procesamiento 
LPGS_15.3.1c LPGS_15.3.1c LPGS_15.3.1c LPGS_15.3.1c LPGS_15.4.0 LPGS_15.5.0 

Elevación del sol Acimut 

solar 
63.07914121 

113.8092375 

65.1202159 

115.7285407 
63.71948556 

120.2109056 

60.364923 

126.6407793 

57.94060758 

126.0281096 

59.32193455 

127.2189511 

Tipo de datos L2 ETM_L2SP OLI_TIRS_L2SP OLI_TIRS_L2SP OLI_TIRS_L2SP OLI_TIRS_L2SP OLI_TIRS_L2SP 

Identificador del sensor ETM OLI_TIRS OLI_TIRS OLI_TIRS OLI_TIRS OLI_TIRS 

Satélite 7 8 8 8 8 8 

Proyección del mapa del 

producto L2 
UTM UTM UTM UTM UTM UTM 

Zona UTM 17 17 17 17 17 17 

Datum WGS84 WGS84 WGS84 WGS84 WGS84 WGS84 

Corrección de reflectancia Si Si Si Si Si Si 

Corrección radiométrica Si Si Si Si Si Si 

Corrección atmosférica Si Si Si Si Si Si 

Nota: Elaboración propia con datos obtenidos de EarthExplorer (usgs.gov). 

https://earthexplorer.usgs.gov/
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La descarga de imágenes satelitales correspondientes a los 2010, 2016 y 2021 se muestra a 

continuación a manera de demostración.   

Figura 5  

Imagen satelital correspondiente al año 2010  

 

Nota: Obtenido de EarthExplorer (usgs.gov) 

Figura 6  

Imagen satelital correspondiente al año 2016 

 

Nota: Obtenido de EarthExplorer (usgs.gov) 

https://earthexplorer.usgs.gov/
https://earthexplorer.usgs.gov/
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Figura 7  

Imagen satelital correspondiente al año 2021 

 

Nota: Obtenido de EarthExplorer (usgs.gov) 

2.4.4. Corrección de bandeo LANDSAT 7 

La imagen satelital correspondiente al 2010 posee un error de bandeo la cual tuvo que 

ser corregida con el programa Qgis 3.32.3; inicialmente se abren todas las bandas de la imagen 

satelital y todas las bandas de la carpeta gap_mask incluidas en la descarga de la imagen 

satelital, luego seguimos la secuencia Raster > Análisis > Rellenar sin datos, la capa de entrada 

es la banda seleccionada y la máscara de validación será el mismo número de banda de la 

carpeta gap_mask, en el item Distancia máxima a la que interpolar valores se coloca 20 y se 

procede con la ubicación del guardado, el procedimiento se realizó banda por banda. 

https://earthexplorer.usgs.gov/
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Figura 8  

Corrección de imagen satelital Landsat 7 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 

2.4.5. Procesamiento de imágenes satelitales 

La imagen satelital al ser de tipo Level 2 (L2) ya cuenta con corrección de reflectancia, 

radiométrica y atmosférica. En el programa ArcGIS se procesó en primer lugar la imagen 

satelital Landsat 7 correspondiente al año 2010, se cargaron la banda 1, banda 2 y banda 3 para 

su unión de la siguiente manera Windows > Image Analysis> (selección de las 3 bandas) > 

Composite Bands > (selecciona la banda creada) > Export, en la banda creada se selecciona el 

orden de las bandas de la siguiente manera: banda 3, banda 2 y banda 1 para obtener el color 

real, con el archivo raster unido el area de interés se recortó en forma de rectángulo de la 

siguiente forma:  ArcToolbox > Data Management Tools > Raster > Raster Processing > Clip.  
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Figura 9  

Unión de bandas de imagen satelital Landsat 7 del 2010 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 

 En segundo lugar las imágenes satelitales Landsat 8 al ser de tipo Level 2 (L2) ya 

cuenta con corrección de reflectancia, radiométrica y atmosférica, estas imágenes  

correspondientes a los años 2013, 2016, 2018, 2020 y 2021, se cargaron la banda 2, banda 3 y 

banda 4 para su unión de la siguiente manera Windows > Image Analysis> (selección de las 3 

bandas) > Composite Bands > (selecciona la banda creada) > Export, en la banda creada se 

selecciona el orden de las bandas de la siguiente manera: banda 4, banda 3 y banda 2 para 

obtener el color real, con el archivo raster unido el área de interés se recortó en forma de 

rectángulo como se muestra a continuación:  ArcToolbox > Data Management Tools > Raster 

> Raster Processing > Clip. 
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Figura 10  

Unión de bandas de imagen satelital Landsat 8 del 2016 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 

Figura 11  

Unión de bandas de imagen satelital Landsat 8 del 2021 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Después de obtener las imágenes satelitales recortadas de manera rectangular de los 

años 2010, 2013, 2016, 2018, 2020 y 2021 se procedió a cambiar el sistema de coordenadas a 

WGS 84 UTM Zona 17 Sur, del siguiente modo ArcToolbox > Data Management Tools > 

Projection and Transformations > Define Projection,  

Posterior a ello en la imagen satelital del 2010 de tipo Lansat 7 se recortó la banda 4 y 

banda 3 utilizando como base el shapefile de la delimitación del Parque Nacional de Cutervo 

de la siguiente manera : ArcToolbox > Data Management Tools > Raster > Raster Processing 

> Clip; para la imagen satelital de los años 2013, 2016, 2018, 2020 y 2021 de tipo Landsat 8 

se recortó la banda 5 y banda 4 utilizando como base el shapefile de la delimitación del Parque 

Nacional de Cutervo de la siguiente manera: ArcToolbox > Data Management Tools > Raster 

> Raster Processing > Clip. 

Figura 12  

Recorte de imagen satelital Landsat 7 del 2010 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 



“ANÁLISIS DE LA VARIABILIDAD ESPACIO - TEMPORAL DE LA COBERTURA VEGETAL EN EL 

PARQUE NACIONAL DE CUTERVO DURANTE EL PERIODO 2010 - 2021” 

 

 

Carrasco, H.; Flores, L. Pág. 43 

 

Figura 13  

Recorte de imagen satelital Landsat 8 del 2016 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 

Figura 14  

Recorte de imagen satelital Landsat 8 del 2021 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Luego se procedió a modificar el sistema de coordenadas de cada banda utilizando la 

secuencia que se describe a continuación: ArcToolbox > Data Management Tools > Projection 

and Transformations > Define Projection, de esa forma se transformó el sistema de 

coordenadas a WGS 84 UTM Zona 17 Sur.   

2.4.6. Cálculo del Índice de Vegetación de Diferencia Normalizada (NDVI) 

acorde con Ugaz, (2020) para el cálculo del NDVI Se emplea la fórmula descrita a 

continuación: 

Ecuación 1  

Formula del cálculo de NDVI 

𝑵𝑫𝑽𝑰 =  
(𝑵𝑰𝑹 − 𝑹𝑬𝑫)

(𝑵𝑰𝑹 + 𝑹𝑬𝑫)
 

Donde: 

NDVI = Índice de Vegetación Diferencia Normalizada 

NIR = Reflectancia del Infrarrojo Cercano 

RED = Reflectancia de la banda roja 

Ecuación 2  

Cálculo de NDVI para imágenes satelitales Landsat 7 

𝑵𝑫𝑽𝑰 =  
(𝑩𝒂𝒏𝒅𝒂 𝟒 − 𝑩𝒂𝒏𝒅𝒂 𝟑)

(𝑩𝒂𝒏𝒅𝒂 𝟒 + 𝑩𝒂𝒏𝒅𝒂 𝟑)
 

Para cálculo de imágenes satelitales Landsat 7 se trabaja con bandas, aplicándola de la 

siguiente manera:  

El procedimiento realizado en el software ArcGis para el cálculo del NDVI de la imagen 

satelital Landsat 7 fue utilizando los recortes de las bandas 3 y 4 de la siguiente manera 
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ArcToolbox > Spacial Analyts Tools > Map Algebra > Raster Calculator en la que se aplica 

la Ecuación 2 colocando Float("B4L7A.tif" - "B3L7A.tif") / Float("B4L7A.tif" + "B3L7A.tif"). 

Ecuación 3  

Cálculo de NDVI para imágenes satelitales Landsat 8 

𝑵𝑫𝑽𝑰 =  
(𝑩𝒂𝒏𝒅𝒂 𝟓 − 𝑩𝒂𝒏𝒅𝒂 𝟒)

(𝑩𝒂𝒏𝒅𝒂 𝟓 + 𝑩𝒂𝒏𝒅𝒂 𝟒)
 

El procedimiento realizado en el software ArcGis para el cálculo del NDVI de la imagen 

satelital Lansat 8 fue utilizando los recortes de las bandas 4 y 5 de la siguiente manera 

ArcToolbox > Spacial Analyts Tools > Map Algebra > Raster Calculator donde se aplica la 

Ecuación 3 colocando Float("B5L7A.tif" - "B4L7A.tif") / Float("B5L7A.tif" + "B4L7A.tif"). 

Figura 15  

NDVI para el año 2010 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Figura 16  

NDVI para el año 2016 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 

Figura 17  

NDVI para el año 2021 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Posterior a ello la imagen raster paso a una etapa de clasificación para poder determinar 

las áreas según la clasificación NDVI utilizando el software ArcGIS ArcToolbox > Spacial 

Analyts Tools >Reclass > Reclassify cargamos el raster generado de NDVI seleccionamos el 

item Classify, seleccionamos el valor de 5 en Classes y colocamos los valores establecidos por 

el NDVI para determinar el tipo de cobertura vegetal. El mismo procedimiento se aplicó para 

las clasificaciones NDVI de todos los años. 

Con el raster generado de la clasificación se procedió a convertirlo a formato shapefile 

para el cálculo de las áreas obtenidas de la manera mostrada a continuación ArcToolbox 

>Conversion Tools > From Raster > Raster to Polygon. 

seguidamente, se presenta una secuencia que se realizado para la generación del NDVI 

mediante ModelBuilder (Generador de modelos). 

Figura 18  

ModelBuilder para cálculo de NDVI 

 

Nota: Elaborado por los autores 
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2.4.7. Análisis de datos 

Con los valores de cada nivel de NDVI obtenidos en cada uno de los años analizados 

se procedió a realizar una comparación entre ellos para poder determinar el incremento o la 

disminución de algún tipo de cobertura vegetal. 

2.5.Aspecto Ético 

En esta investigación, los datos se obtuvieron de fuentes gratuitas y disponibles al 

público en general y se utilizaron de manera ética. La presentación de resultados se hizo con 

integridad, evitando manipulaciones, y se destacaron las limitaciones y posibles sesgos en los 

hallazgos. Estos aspectos éticos fueron esenciales para garantizar una investigación 

responsable y beneficiosa tanto para el ambiente y la población local en el Parque Nacional de 

Cutervo, contribuyendo credibilidad y relevancia a esta tesis en el campo de la ingeniería 

ambiental. 
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CAPITULO III: RESULTADOS 

Los hallazgos del Índice de Vegetación de Diferencia Normalizada (NDVI) obtenidos 

a partir de la utilización de imágenes satelitales de los distintos años. revelaron que existe 

cambio en la cobertura vegetal en el Parque Nacional de Cutervo durante el período 2010 - 

2021. Estos resultados proporcionan una visión integral de la dinámica de la vegetación a lo 

largo del tiempo, permitiendo una evaluación detallada del cambio de cobertura vegetal. Estos 

hallazgos son esenciales para comprender mejor la evolución de la cobertura vegetal y como 

afecta el ecosistema del Parque Nacional de Cutervo, lo que a su vez puede ayudar a tomar 

decisiones en materia de conservación y gestión ambiental.  
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Figura 19  

Mapa NDVI para el año 2010 

 
Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 5  

NDVI Parque Nacional de Cutervo en el año 2010 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 84.48 1.03 

2 Suelo desnudo 903.29 11.00 

3 Vegetación escasa 358.65 4.37 

4 
Vegetación medianamente 

densa 
1541.42 18.77 

5 Vegetación densa 5326.39 64.84 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 5 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por la vegetación medianamente densa, suelo desnudo, vegetación 

escasa y cuerpos no vegetales (nubes). 
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Figura 20  

Mapa NDVI para el año 2013 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 6  

NDVI Parque Nacional de Cutervo en el año 2013 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 862.02 10.49 

2 Suelo desnudo 413.72 5.04 

3 Vegetación escasa 927.95 11.30 

4 
Vegetación medianamente 

densa 
1205.67 14.68 

5 Vegetación densa 4804.87 58.49 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 6 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por la vegetación medianamente densa, vegetación escasa, 

cuerpos no vegetales y suelo desnudo. En este análisis notamos un incremento de los cuerpos 

no vegetales identificados como nubes. 
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Figura 21  

Mapa NDVI para el año 2016 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 7  

NDVI Parque Nacional de Cutervo en el año 2016 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 514.61 6.26 

2 Suelo desnudo 704.41 8.58 

3 Vegetación escasa 286.55 3.49 

4 
Vegetación medianamente 

densa 
1620.46 19.73 

5 Vegetación densa 5088.2 61.94 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 7 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por la vegetación medianamente densa, cuerpos no vegetales 

(nubes), suelo desnudo, vegetación escasa. 
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Figura 22  

Mapa NDVI para el año 2018 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 8  

NDVI Parque Nacional de Cutervo en el año 2018 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 157.13 1.91 

2 Suelo desnudo 329.85 4.02 

3 Vegetación escasa 871.02 10.60 

4 
Vegetación medianamente 

densa 

1492.93 18.17 

5 Vegetación densa 5363.3 65.29 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 8 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por la vegetación medianamente densa, vegetación escasa, suelo 

desnudo y cuerpos no vegetales (nubes). 
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Figura 23  

Mapa NDVI para el año 2020 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 9  

NDVI Parque Nacional de Cutervo en el año 2020 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 1065.85 12.98 

2 Suelo desnudo 493.92 6.01 

3 Vegetación escasa 825.66 10.05 

4 
Vegetación medianamente 

densa 

1046.36 12.74 

5 Vegetación densa 4782.44 58.22 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 9 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por los cuerpos no vegetales (nubes), vegetación medianamente 

densa, vegetación escasa y suelo desnudo. 
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Figura 24  

Mapa NDVI para el año 2021 

 

Nota: Elaboración propia asistida con el Software ArcGIS 10.8 
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Tabla 10  

NDVI Parque Nacional de Cutervo en el año 2021 

Código Cobertura Vegetal 
Área  

(Ha) 

Porcentaje  

(%) 

1 Cuerpos no vegetales 204.38 2.49 

2 Suelo desnudo 1018.75 12.40 

3 Vegetación escasa 385.14 4.69 

4 
Vegetación medianamente 

densa 

1726.38 21.02 

5 Vegetación densa 4879.58 59.40 

 TOTAL 8214.23 100 

Nota: Elaboración propia 

En la Tabla 10 podemos identificar que la mayor cantidad de vegetación identificada es 

la vegetación densa, seguida por la vegetación medianamente densa, suelo desnudo, vegetación 

escasa, y cuerpos no vegetales (nubes).  
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Figura 25  

Variación de NDVI del 2010 al 2021 

 

Nota: Elaboración propia 

En la ilustración número 25 se representa el resultado obtenido del análisis NDVI para 

el periodo 2010 – 2021 en el que se logró obtener información correspondiente a los años 2010, 

2013, 2016, 2018, 2020 y 2021. Los valores están representados en hectáreas (Ha) para su 

mejor comprensión, como se muestra en la ilustración los valores obtenidos varían entre cada 

año, esto es debido a la presencia de cuerpos no vegetales como lo son las nubes y sus 

respectivas sombras, estas alteran los resultados porque se ubicaron aleatoriamente en el área 

de estudio. Por lo cual cada parámetro del NDVI se realizará su interpretación de manera 

individual en relación al periodo de estudio. 
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Figura 26  

Correlación entre suelo desnudo y el periodo de tiempo analizado 

 

Nota: Elaboración propia 

El análisis de correlación reveló un coeficiente de correlación (r2=0.0014) que se 

traduce a un valor de r de 0.0374 para la variable de suelo desnudo en relación al periodo de 

tiempo 2010 - 2021. Este valor de r sugiere una correlación extremadamente débil entre la 

variación en la cobertura de suelo desnudo y el tiempo evaluado. Lo que sugiere que las 

variaciones en la cobertura de suelo desnudo son afectadas por distintos factores. 
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Figura 27  

Correlación entre vegetación escasa y el periodo de tiempo analizado 

 

Nota: Elaboración propia 

El análisis de correlación reveló un coeficiente de correlación (r2=0.0172) que se 

traduce a un valor de r=0.1311 para la variable de vegetación escasa en relación al periodo de 

tiempo 2010 – 2021. Este valor muestra una correlación débil entre la variación en la cobertura 

de vegetación escasa y el tiempo evaluado en el Parque Nacional de Cutervo. Aunque la 

relación es débil, es significativa y sugiere una tendencia positiva. Esto implica que a medida 

que avanza el tiempo, existe un aumento leve pero detectable en la presencia de vegetación 

escasa en la región. Sin embargo, es esencial considerar la influencia de factores adicionales 

como condiciones climáticas, cambios en el uso del suelo y otros aspectos ambientales que 

podrían estar contribuyendo a esta variación en la vegetación. 
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Figura 28  

Correlación entre vegetación medianamente densa y el periodo de tiempo analizado 

 

Nota: Elaboración propia 

El análisis de correlación reveló un coeficiente de correlación (r2=0.0001) que se 

traduce a un valor de r de 0.01 para la variable de vegetación medianamente densa en relación 

con el periodo de tiempo 2010 - 2021. Este valor indica una correlación extremadamente débil. 

Lo que sugiere que las variaciones en la cobertura de suelo desnudo son afectadas por distintos 

factores. 
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Figura 29  

Correlación entre vegetación densa y el periodo de tiempo analizado 

 

Nota: Elaboración propia 

El análisis de correlación reveló un coeficiente de correlación (r2=0.1612) que se 

traduce a un valor de r de 0.4015 para la variable de vegetación densa en relación con el periodo 

de tiempo 2010 - 2021. Este valor indica una correlación moderada, además sugiere una 

relación específica entre la variación en la cobertura de vegetación densa y el tiempo, lo que 

indicaría que a lo largo del tiempo este tipo de cobertura tendera a disminuir. 

 Dentro de los factores implicados en la obtención de estos resultados podemos resaltar 

tres: la presencia de cuerpos no vegetales en las imágenes satelitales descargadas como lo son 

las nubes y sus sombras proyectadas en la superficie, el segundo factor son las actividades 

antrópicas ocasionadas por los residentes aledaños al área de estudio y por último tenemos a 

los fenómenos naturales que generan cambios de cobertura vegetal, estos se describen a 

continuación. 
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Figura 30 

Imagen satelital Parque Nacional de Cutervo en el año 2013 

 

Nota: Tomado de Google Earth, Maxar Technologies, 2023. 

Figura 31  

Imagen satelital Parque Nacional de Cutervo en el año 2020 

 

Nota: Tomado de Google Earth, Maxar Technologies, 2023. 
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En las figuras anteriores, la figura 30 corresponde al año 2013 y la figura 31 

corresponde al año 2020, en ambas imágenes se puede observar la presencia de nubosidad 

sobre el área de estudio el cual es el Parque Nacional de Cutervo, lo cual altera la distribución 

normal de las coberturas vegetales para estimar el NDVI. La nubosidad actúa como un 

obstáculo para la captación de la radiación proveniente de la superficie de la tierra, afectando 

la capacidad del sensor satelital para discriminar y cuantificar adecuadamente las coberturas 

vegetales. Como se nota en ambas imágenes la influencia de la nubosidad varía acorde a las 

condiciones climatológicas. Además, la variabilidad en la presencia de nubosidad entre los 

años de estudio puede explicar en parte las fluctuaciones observadas en los resultados del 

análisis de correlación.  

Figura 32  

Imagen satelital de un sector del Parque Nacional de Cutervo en el año 2011 

 

 Nota: Tomado de Google Earth, Maxar Technologies, 2023. 
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Figura 33  

Imagen satelital de un sector del Parque Nacional de Cutervo en el año 2019 

 

Nota: Tomado de Google Earth, CNES/Airbus, 2023. 

La variabilidad de la cobertura vegetal en el Parque Nacional de Cutervo también se ve 

influenciada por una serie de condiciones climáticas y eventos naturales que han marcado la 

dinámica ambiental en el área de estudio. Los cambios en las condiciones del clima, como 

variaciones en los patrones de temperaturas y precipitación, han tenido repercusiones directas 

en la distribución de la vegetación. Como se muestra en las figuras 32 y 33 la presencia de 

deslizamientos en distintas áreas del área estudiada a lo largo del periodo del tiempo evaluado 

cambia la distribución de la cubierta vegetal, la topografía de la zona de estudio influye en la 

distribución de la cobertura vegetal. Los incendios forestales, ya sean provocados por 

actividades humanas o causados por eventos naturales como rayos, son otro factor a considerar, 

ya que pueden cambiar la composición de la cobertura vegetal y dañar su capacidad de 

regeneración. La fecha en que se obtiene la imagen satelital también influye en los resultados 
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obtenidos, dado que en los meses de precipitación la cobertura vegetal tiende a incrementarse 

y en los meses de estiaje esta tiende a reducirse, generando variaciones en los datos obtenidos 

entre año a año. Los cambios en los ciclos de vida de la vegetación, como periodos de floración, 

fructificación y caída de hojas, también están vinculadas a las condiciones climáticas. Estos 

ciclos influyen en los valores del NDVI a lo largo del año. 

El cambio en el uso del suelo, causada por las acciones humanas, se evidencian como 

un actor determinante en las variaciones de la cobertura vegetal en el Parque Nacional de 

Cutervo. La práctica de la deforestación ha sido especialmente significativa, marcando la 

conversión de áreas boscosas para la expansión de la agricultura y otros propósitos. Este 

cambio radical en la utilización del suelo no solo ha resultado en la pérdida de hábitats 

naturales, sino que también ha alterado fundamentalmente la estructura de la vegetación, 

ejerciendo una influencia directa en la dinámica del ecosistema. Las actividades agrícolas han 

ejercido una presión substancial sobre la cobertura vegetal en la zona de estudio. La rotación 

de cultivos, el uso extensivo de agroquímicos y la expansión de áreas cultivadas han 

modificado la composición de la vegetación de manera significativa. 
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CAPITULO IV: DISCUSIÓN Y CONCLUSIONES 

Discusión 

Los hallazgos obtenidos en esta investigación revelan cambios en la cobertura vegetal 

en el Parque Nacional de Cutervo a lo largo del período de estudio (2010-2021). Uno de los 

hallazgos más destacados es el incremento del 12.78% en la presencia de suelo desnudo en la 

región. Este aumento puede deberse a múltiples factores, como la erosión, la actividad humana 

o eventos climáticos extremos, que han dejado áreas previamente cubiertas de vegetación 

expuestas. Esta tendencia plantea preocupaciones sobre la disminución de la cubierta vegetal 

y la degradación del suelo en el área natural protegida. Por otro lado, se observó un incremento 

del 7.39% en áreas con vegetación escasa. Este aumento podría estar relacionado con procesos 

de regeneración natural o, en algunos casos, con prácticas de restauración ecológica. También 

se identificó el incremento del 12% en la vegetación semi densa directamente relacionado al 

incremento de las áreas de cultivo y pastoreo. Por otro lado, resulta preocupante la reducción 

del 8.39% en la vegetación densa, debido a que este tipo de cobertura vegetal es esencial para 

mantener la estabilidad del ecosistema y la biodiversidad. Esta disminución podría ser atribuida 

a la tala, la expansión de actividades humanas o cambios en las condiciones climáticas que 

afectan negativamente a la vegetación densa. 

En conjunto, estos resultados subrayan la dinámica compleja y multifacética de la 

cubierta vegetal y el uso del suelo en el Parque Nacional de Cutervo. La conservación y la 

gestión sostenible de este importante ecosistema requieren una comprensión más profunda de 

las causas subyacentes de estos cambios. Además, es fundamental tener en cuenta estos 

hallazgos y asi crear políticas y estrategias de conservación que aborden los problemas 

específicos del área protegida. 
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En el estudio realizado se demostró que existe cambio de la cobertura vegetal en el 

Parque Nacional de Cutervo provocado por diversos factores, entre ellos la erosión, la actividad 

humana o eventos climáticos extremos, nuestros resultados se ven contrastados con el estudio 

elaborado por Granados et al. (2022), en el que determinaron el proceso de degradación de 

laderas asociado a la perdida de cobertura vegetal, denotando que la erosión es una de las causas 

principales.  

Uno de los hallazgos más significativos de nuestro estudio fue que se presentó una 

disminución del 8.39% de vegetación densa correspondiente a bosque durante un periodo de 

once años, contrastando con la investigación de Leija et al. (2020) el cual indica que la 

cobertura vegetal se deforesto el 32.1% en veintiséis años. Dando a conocer que la cobertura 

boscosa es una de las más afectadas en el pasar del tiempo y es la que más tendencia tiene a 

reducirse si no se le da un apropiado manejo.  

En la investigación elaborado por Morales et al., (2016) determinó que los usos 

relacionados con la agricultura, incluidos los procesos dinámicos como la conversión a 

vegetación secundaria, están creciendo más a expensas de las áreas de bosques y selvas, y se 

ha observado una mayor tasa de deforestación en los últimos tiempos. Considerando que en el 

Parque Nacional de Cutervo se está manifestando de igual manera dado que se evidencia un 

notorio incremento de zonas de cultivo y pastoreo. 

Al haber obtenido resultados con una tendencia a incrementarse el suelo desnudo, la 

vegetación escasa con tendencia a disminuir, la vegetación medianamente densa con una 

tendencia a incrementarse y una vegetación densa con alta tendencia a seguir disminuyendo, 

estos resultados ocasionados por distintos factores denotan una variación de la cobertura 

vegetal en el Parque Nacional de Cutervo, de igual manera se ve referenciado en la 

investigación realizada por Zuloaga & Gabriel (2023), Sus hallazgos demostraron que las capas 
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de suelos intervenidos y cobertura vegetal cambiaron a lo largo de los años de investigación, 

cada uno se encuentran dentro de las áreas de uso especial y amortiguamiento del Parque 

Nacional, los cuales estan relacionados con la agricultura extensiva enfocada en el mercado 

local y el autoconsumo. 

Una de las principales razones por la disminución de la cobertura vegetal densa e 

incremento de vegetación medianamente densa es el factor antrópico, es el principal ente que 

modifica los ecosistemas, ya que para satisfacer sus necesidades se ve obligado a alterar el 

medio que lo rodea, en este caso mediante la tala de los bosques para aprovechar la madera e 

incrementar las zonas de cultivo y pastos para animales, de igual forma esto también se ve 

evidenciado en otras zonas de nuestro país, Guerra (2020), demostró una disminución de la 

cobertura vegetal de 1.73% en toda la extensión del área de estudio. La provincia de Lima 

presentó un descenso de 2769.5 Ha en cobertura vegetal; además, estas coberturas presentan 

una relación del 86% con el crecimiento de la población.   

En específico, observamos que la mayor área de nuestro estudio está conformada por 

cobertura vegetal densa durante todo el periodo de evaluación. Sin embargo, se puede notar 

una reducción significativa del 8.39% en la cobertura vegetal densa en el periodo que oscila 

entre 2011 a 2021. En concordancia con la investigación realizada por Pinzón (2022), quien 

determinó que las coberturas de roca se presentan con más frecuencia, llegando a ocupar 9025.5 

hectáreas (47.51% del área del distrito) en promedio, además que en el espacio- tiempo la 

cobertura semi densa es la más invariable, nuestro estudio presenta resultados que se alinean 

con dicha perspectiva 

En nuestro estudio obtuvimos que el suelo desnudo se incrementó en un 12.78%, la 

vegetación escasa se incrementó en un 7.39%, la vegetación semi densa se incrementó en un 

12% y la vegetación densa se redujo en un 8.39% durante el periodo 2010 – 2021, en 
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concordancia con la investigación de Gutierrez & Vilchez (2022), sus resultados mostraron que 

la degradación más grave de cobertura de tipo forestal se produjo durante el período de 2016 a 

2018 equivalente a -8.23 %, en el periodo de 2010 a 2012 un porcentaje de -6.59 y un porcentaje 

de 0.28 en el periodo de 2014 a 2016. 

Conclusiones 

En la presente investigación, luego de procesar y analizar los resultados: 

Primero: Se da por valida la hipótesis alternativa ya que existe una variación superior 

al 5% en cada tipo de cobertura vegetal del Parque Nacional de Cutervo durante el periodo 

2010-2021. Obteniendo que el suelo desnudo se ha incrementado en 115.46 ha siendo 

equivalente a un 12.78%, la vegetación escasa se incrementó en 26.49 ha equivalente a un 

7.39%, la vegetación semi densa se incrementó en 184.96 ha equivalente a un 12% y la 

vegetación densa se redujo en 446.81 ha de bosque equivalente a un 8.39%, en el periodo del 

2010 al 2021 se ha evidenciado un incremento en áreas de suelo desnudo y vegetación escasa, 

así como un incremento en vegetación semi densa y una reducción en vegetación densa. Estos 

cambios reflejan la interacción entre procesos naturales y actividades humanas. 

Segundo: Se desarrolló el Índice de Vegetación de Diferencia Normalizada (NDVI) a 

lo largo de los años 2010, 2013, 2016, 2018, 2020 y 2021. El desarrollo de este índice 

proporcionó la información cuantitativa de cada año, posibilitando un análisis detallado de la 

variabilidad espacio- temporal de la cobertura vegetal en el área de estudio, así mismo, 

permitiendo la clasificación según la cobertura vegetal identificada. 

Tercero: Dentro de los factores identificados en la variabilidad espacio temporal de la 

cobertura vegetal en el Parque Nacional de Cutervo durante el periodo 2010 – 2021, como 

factor externo tenemos la presencia de nubosidad y la proyección de sombras sobre el área de 

estudio, lo que representa un obstáculo para obtener datos acordes a la realidad, otro de los 
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factores son las condiciones ambientales del área estudiada, ya que la temperatura, la humedad, 

la precipitación, la erosión, los deslizamientos, incendios forestales entre otros, ocasionan 

variabilidad espacio-temporal sobre la cobertura vegetal y por último el factor antropogénico 

es uno de los que causa mayor afectación a la cobertura vegetal mediante la tala indiscriminada, 

la generación de incendios forestales, incremento de zonas de cultivo y ganadero. 

Cuarto: Como medidas de gestión sostenible para la conservación de la cobertura 

vegetal en el PNC se plantean las siguientes: Sugerir e implementar y ejecutar un sistema de 

seguimiento continuo mediante tecnologías de teledetección para evaluar las dinámicas de la 

cobertura vegetal y permitir respuestas ágiles a cambios significativos. Desarrollar programas 

de restauración de ecosistemas, centrados en la reforestación y recuperación de áreas 

degradadas. La participación activa de las comunidades locales se destaca como esencial. 

Desarrollar programas educativos dirigidos tanto a la población de la zona como a turistas 

puede aumentar la comprensión sobre la importancia de la cobertura vegetal y generar un 

mayor compromiso con la conservación. Establecer rutas turísticas bien definidas y promover 

prácticas de bajo impacto puede generar ingresos económicos para la comunidad sin 

comprometer la integridad del ecosistema. 
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